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 Abstract: 

 

Cardiac arrhythmias pose a significant burden on global health, contributing 

to morbidity and mortality worldwide. Ion channels play a crucial role in 

cardiac physiology, and dysfunction in these channels is implicated in the 

pathogenesis of various arrhythmia syndromes. Conventional drugs, which 

are often prescribed to treat cardiac arrhythmias, are costly and have 

negative effects. Therefore, a more reliable, affordable, and powerful 

alternative is needed. Medicinal herbs are, thus, the most important kind of 

treatment for cardiac arrhythmia.  

 

 This dissertation explores the computational discovery of phytochemical 

for targeting protein which in turn target ion channels implicated in cardiac 

arrhythmias, focusing on molecular docking simulations and understanding 

therapeutic approach by using herbal plant. Key findings include the 

identification of potential phytochemical with the ability to modulate ion 

channel function and restore normal cardiac rhythm. Insights into the 

mechanism of action of cardiac glycoside reveal their ability to regulate 

cardiac rhythm by primarily increasing vagal tone, which slows AV node 

conduction and reduces the ventricular rate. The implications for drug 

discovery and therapeutic development are discussed, highlighting the 

potential of phytochemical as a precision medicine approach for 

personalized treatment strategies tailored to the underlying molecular 

mechanisms of arrhythmia subtypes. Recommendations for future research 

include experimental validation of lead compounds, structural biology 

studies to elucidate ligand-protein interactions, clinical translation of 

computational predictions, and the investigation of personalized medicine 

approaches based on patient-specific genetic mutations. By addressing 

these recommendations, the field can further advance our understanding of 

cardiac arrhythmias and facilitate the development of innovative 

therapeutic interventions for improving patient care and outcomes. 

 

 

Keywords:  

cardiac arrhythmias, ion channels, molecular docking, structure-based  drug  

design, precision medicine, computational modeling, drug discovery,  

therapeutic development. 
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CHAPTER 1 

 

INTRODUCTION 

 

 

 

Cardiac arrhythmias pose a significant challenge in contemporary 

healthcare, contributing to morbidity and mortality worldwide. These 

irregularities in heart rhythm are often rooted in the malfunction of ion 

channels, crucial components orchestrating the cardiac electrical signaling 

cascade. The intricate interplay of these channels, regulating the influx and 

efflux of ions across the cellular membrane, is paramount for maintaining 

cardiac rhythmicity. However, dysregulation of ion channels can lead to 

arrhythmogenic conditions, ranging from benign palpitations to life-

threatening ventricular fibrillation. 

 

According to Robbins and Cotran (2021), "Cardiac arrhythmias encompass 

a broad spectrum of rhythm disturbances, from benign premature 

contractions to life-threatening ventricular fibrillation, posing significant 

challenges in both diagnosis and management" (p. 178). This underscores 

the clinical urgency and complexity associated with arrhythmia 

management. 

 

To address this challenge, researchers have explored novel therapeutic 

avenues, among which phytochemicals use emerges as a promising strategy. 

Plants create bioactive substances called phytochemicals to defend 

themselves. More than a thousand phytochemicals have been identified to 

far, and they may be obtained from a variety of foods, including whole 

grains, fruits, vegetables, nuts, and herbs. Significant phytochemicals include 

dietary fibers, certain polysaccharides, carotenoids, polyphenols, 

isoprenoids, phytosterols, and saponins. These phytochemicals have 
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antibacterial, antidiarrheal, anthelmintic, antiallergic, antispasmodic, and 

antiviral properties in addition to their potent antioxidant activity(1) 

 

Leveraging computational techniques such as molecular docking, 

researchers can         systematically screen vast chemical libraries to 

identify potential phytochemical with therapeutic efficacy. 

 

In this dissertation, we delve into the realm of computational study of 

phytochemical, focusing on the identification of phytochemical targeting 

ion channels implicated in cardiac arrhythmias. In addition, we explore the 

potential of different compounds derived from Nerium oleander to 

modulate ion channel activity. Through a molecular docking simulations, 

we investigate its binding affinity and potential effects, contributing to the 

comprehensive understanding of arrhythmia pathophysiology and paving 

the way for innovative therapeutic interventions. 

 

 

1.2  Background and Significance of Cardiac Arrhythmias 

 

Cardiac arrhythmias represent a diverse array of rhythm disturbances, 

ranging from benign palpitations to life-threatening conditions such as 

ventricular fibrillation. These irregularities in the heart's electrical activity 

disrupt its ability to pump blood effectively, leading to symptoms such as 

dizziness,  chest pain, and in severe cases, sudden cardiac arrest (Robbins & 

Cotran, 2021). 

 

The prevalence of cardiac arrhythmias is substantial, with millions of 

individuals affected globally. Age, genetics, structural heart disease, 

electrolyte imbalances, and medication side effects are among the 

multifactorial contributors to arrhythmia development (Ziaeian & Fonarow, 

2016). Importantly, cardiac arrhythmias pose significant challenges in both 
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diagnosis and management, necessitating a comprehensive understanding 

of their underlying mechanisms. 

 

Robbins and Cotran (2021) underscore the clinical significance of cardiac 

arrhythmias, stating that they "encompass a broad spectrum of rhythm 

disturbances, posing significant challenges in both diagnosis and 

management" (p. 178). Indeed, the unpredictable nature of arrhythmias and 

their potential for adverse outcomes necessitate ongoing research efforts to 

improve risk stratification, diagnostic modalities, and therapeutic 

interventions. 

 

From a pathophysiological standpoint, cardiac arrhythmias often arise from 

abnormalities in the generation or propagation of electrical impulses within 

the heart. Dysregulation of ion channels, specialized proteins embedded in 

the cardiac cell membrane, plays a pivotal role in disrupting the finely 

orchestrated sequence of electrical events. Alterations in ion channel 

function can lead to aberrant depolarization or repolarization, culminating 

in arrhythmogenic substrates predisposing individuals to various rhythm 

disturbances (Nattel et al., 2017). 

 

Understanding the underlying molecular mechanisms driving cardiac 

arrhythmias is essential for the development of targeted therapies aimed at 

restoring normal electrical activity and reducing morbidity and mortality 

associated with these conditions. Moreover, advancements in computational 

techniques, such as molecular docking, offer promising avenues for the 

discovery of novel therapeutic agents capable of modulating ion channel 

function with precision and efficacy. 

 

 

1.3 Role of Ion Channels in Cardiac Physiology 
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Ion channels are integral membrane proteins responsible for regulating the 

flow of ions across the cell membrane, thereby governing the electrical 

excitability of cardiac myocytes. These specialized channels play a 

fundamental role in orchestrating the complex sequence of events 

underlying cardiac physiology, including action potential generation, 

propagation, and contraction (Bers, 2002). 

 

In the context of cardiac electrophysiology, several types of ion channels 

contribute to the dynamic changes in membrane potential during each 

cardiac cycle. Sodium (Na^+), potassium (K^+), calcium (Ca^2+), and 

chloride (Cl^-) channels are among the key players involved in mediating 

the influx and efflux of ions, thereby modulating the electrical properties of 

cardiac cells (Noble et al., 2010). 

 

During the resting membrane potential phase, ion channels maintain a 

polarized state by selectively allowing specific ions to permeate the 

membrane. Upon depolarization, voltage-gated sodium channels rapidly 

open, allowing a transient influx of sodium ions, which initiates the action 

potential. Subsequent activation of voltage-gated potassium channels 

facilitates repolarization by promoting the efflux of potassium ions, 

restoring the resting membrane potential (Bers, 2002). 

 

In addition to sodium and potassium channels, calcium channels play a 

crucial role in excitation-contraction coupling, where calcium influx 

triggers calcium release from the sarcoplasmic reticulum, leading to 

myocardial contraction. These intricate processes are tightly regulated to 

ensure proper cardiac function and maintain hemodynamic stability (Bers, 

2002). 

 

The role of ion channels extends beyond normal cardiac physiology, as 

their dysregulation can give rise to arrhythmogenic substrates predisposing 

individuals to cardiac arrhythmias. Abnormalities in ion channel function, 
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whether due to genetic mutations, acquired disorders, or pharmacological 

interventions, can disrupt the delicate balance of ion fluxes, leading to 

conduction abnormalities and rhythm disturbances (Noble et al., 2010). 

 

Understanding the intricate interplay between ion channels and their 

contribution to cardiac electrophysiology is paramount for elucidating the 

pathophysiological mechanisms underlying cardiac arrhythmias.  

 

 

1.4 Phytochemical  as a Therapeutic Approach 

 

Conventional drugs, which are often used to treat cardiovascular diseases, 

are costly and have negative effects. Therefore, a more reliable, affordable, 

and powerful alternative is needed. Medicinal herbs are therefore the most 

important kind of treatment for cardiovascular disease. Treatment of CVDs 

is more likely to involve medicinal herbs. Due to increased understanding 

of how herbs enhance health and quality of life, herbal medicine has been 

widely accepted in medicine. A different and promising approach to CVD 

prevention is the use of phytochemicals and plant-based whole meals, 

according to mounting data. Arrhythmia, congestive heart failure, cerebral 

and venous insufficiency, atherosclerosis, angina pectoris, and systolic 

hypertension have all been treated with herbal remedies. In addition to 

therapeutic herbs, exercise is believed to cardioprotective in nature. 

 

 Natural goods contain a wide variety of chemical entities that are included 

in the phytochemical category, including vitamins, flavonoids, steroidal 

saponins, polyphenols, and organosulfur compounds. Numerous bioactive 

substances that are often derived from terrestrial plants, including 

diosgenin, resveratrol, quercetin, sulforaphane, tocotrienols, and 

carotenoids, have been shown to lower the risk of cardiovascular illnesses 

and support cardioprotection, which is important because cardiovascular 

disease is the world's leading cause of death. These include isoflavones, 
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diosgenin, resveratrol, quercetin, catechin, sulforaphane, tocotrienols, and 

carotenoids. The antioxidative, antihypercholesteroemic, antiangiogenic, 

anti-ischemic, suppression of platelet aggregation, and anti-inflammatory 

properties of the different phytochemicals may be responsible for their 

cardioprotective benefits.(2) 

 

Despite the immense potential of phytochemicals, several challenges 

remain, including identifying standardization, bioavailability, efficacy and 

safety while using phytochemical in treatments. Nonetheless, advances in 

computational techniques, such as molecular docking, have facilitated the 

identification and screening of phytochemicals, accelerating drug discovery 

efforts in this field. 

 

 

1.5   Molecular Docking as a Computational Tool 

 

Molecular docking serves as a powerful computational tool for predicting 

the binding interactions between small molecules (ligands) and target 

proteins, such as ion channels, with high accuracy and efficiency. This 

technique plays a pivotal role in drug discovery and design by facilitating 

the identification of potential lead compounds that selectively bind to 

specific protein targets, thereby modulating their activity (Morris et al., 

2009). 

 

At its core, molecular docking involves the computational simulation of 

ligand-protein interactions within the three-dimensional space of the 

protein's binding site. By employing algorithms that account for factors 

such as ligand flexibility, protein conformational changes, and electrostatic 

complementarity, docking programs can predict the most energetically 

favorable binding pose of a ligand within the protein's binding pocket 

(Kitchen et al., 2004). 
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The accuracy and reliability of molecular docking simulations depend on 

several factors, including the quality of the protein structure, the choice of 

scoring function, and the incorporation of solvent effects and protein 

flexibility (Leach et al., 2006). Additionally, validation against 

experimental data, such as crystallographic structures or binding affinity 

measurements, is essential for assessing the predictive performance of 

docking algorithms. 

 

Despite its computational nature, molecular docking has proven to be a 

valuable tool in virtual screening campaigns aimed at identifying potential 

drug candidates from large chemical libraries. By screening millions of 

compounds in silico, researchers can prioritize promising leads for further 

experimental validation, thereby accelerating the drug discovery process 

and reducing the time and cost associated with traditional high-throughput 

screening methods (Kitchen et al., 2004). 

 

In the context of ion channels implicated in cardiac arrhythmias, molecular 

docking holds immense promise for identifying allosteric modulators with 

therapeutic potential. By virtually screening chemical libraries against ion 

channel structures, researchers can pinpoint compounds that interact with 

specific allosteric sites, thereby modulating channel function and restoring 

normal cardiac rhythm (Kolb et al., 2011). 

 

    1.6 Research Objectives and Scope 

 

The primary objective of this research is to leverage molecular docking 

techniques to identify potential phytochemical targeting protein implicated 

in cardiac arrhythmias. Specifically, the study aims to: 

 

1. Select a protein which is known to play critical roles in cardiac 

electrophysiology and arrhythmogenesis, based on a comprehensive 

review of the literature and expert consultation. 
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2. Compile a database of phytochemical with the potential to act as ligand, 

drawing from diverse chemical libraries and bioactivity databases. 

 

3. Utilize molecular docking simulations to predict the binding interactions 

between selected protein and phytochemical which as a ligand, 

considering ligand flexibility and receptor conformational changes. 

 

4. Validate the docking results through comparison with experimental data, 

where available, to assess the reliability and predictive performance of 

the computational approach. 

 

5. Analyse the top-ranking docking poses and scoring metrics to prioritize 

lead compounds for further experimental evaluation, considering factors 

such as binding affinity, specificity, and drug-likeness. 

 

6. Discuss the implications of the findings for the development of novel 

therapeutic strategies targeting different ion channels in cardiac 

arrhythmias. 

 

The scope of the research encompasses computational and theoretical 

investigations aimed at elucidating the molecular mechanisms underlying 

ion channel modulation and arrhythmia pathophysiology. While the study 

primarily focuses on molecular docking as a predictive tool, it integrates 

principles from structural biology, pharmacology, and bioinformatics to 

provide a comprehensive understanding of the phytochemicals targeting ion 

channels. 
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CHAPTER 2 

 

Literature Review 

 
 

 

Cardiac arrhythmias represent a diverse spectrum of rhythm disturbances 

that pose significant challenges in both diagnosis and management 

(Robbins & Cotran, 2021). These abnormalities in cardiac rhythm can 

range from benign premature contractions to life-threatening ventricular 

fibrillation, underscoring the clinical urgency and complexity associated 

with arrhythmia management. The prevalence of cardiac arrhythmias is 

substantial, affecting millions of individuals globally, and is influenced by 

various factors including age, genetics, structural heart disease, electrolyte 

imbalances, and medication side effects (Ziaeian & Fonarow, 2016). 

Consequently, there is a pressing need for comprehensive research to 

enhance our understanding of arrhythmia pathophysiology and develop 

effective therapeutic interventions. 

 

Ion channels play a pivotal role in cardiac electrophysiology, regulating the 

influx and efflux of ions across the cellular membrane to maintain normal 

cardiac rhythm (Nattel et al., 2017). Abnormalities in ion channel function 

can disrupt the delicate balance of ion fluxes, leading to conduction 

abnormalities and arrhythmogenic substrates predisposing individuals to 

various rhythm disturbances. Understanding the molecular basis of ion 

channel dysfunction is essential for elucidating the underlying mechanisms 

of cardiac arrhythmias and identifying potential therapeutic targets. 

 

Traditional plant-based remedies have been used extensively in health care 

from ancient      times to the present. Natural bioactive substances called 

phytochemicals are present in fruits,  vegetables, medicinal plants, fragrant 
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plants, leaves, flowers, and roots. They function as the body's defensive 

mechanism against illness. Their presence of anti-inflammatory, anti-

arrhythmic, and antioxidant substances contributes to the preservation of 

cardiovascular health in general. Thus, we can target the ion channels 

linked to cardiac arrhythmias by using phytochemicals to target a specific 

heart protein, which leads to the development of a therapeutic method.(2) 

 

Molecular docking serves as a powerful computational tool for predicting 

the binding interactions between small molecules (ligands) and target 

proteins, such as ion channels, with high accuracy and efficiency (Morris et 

al., 2009). By simulating ligand-protein interactions within the three-

dimensional space of the protein's binding site, docking programs can 

predict the most energetically favorable binding pose of a ligand, 

facilitating the identification of potential lead compounds for further 

experimental validation. Despite its computational nature, molecular 

docking has proven to be a valuable tool in virtual screening campaigns 

aimed at identifying potential drug candidates from large chemical libraries. 

 

 

2.1 Overview of Cardiac Arrhythmias and Their Impact 

 

Cardiac arrhythmias encompass a spectrum of rhythm disturbances that can 

significantly impact cardiovascular health and patient outcomes (Robbins & 

Cotran, 2021). These disturbances in the heart's electrical activity can 

manifest as irregular heartbeats, palpitations, and in severe cases, life-

threatening arrhythmias such as ventricular fibrillation. The prevalence of 

cardiac arrhythmias is substantial, affecting millions of individuals 

worldwide and representing a leading cause of morbidity and mortality in 

both developed and developing countries (Ziaeian & Fonarow, 2016). 

 

The impact of cardiac arrhythmias on patient health and quality of life is 

multifaceted. Arrhythmias can lead to symptoms such as dizziness, 
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lightheadedness, chest pain, and shortness of breath, which can 

significantly impair daily functioning and diminish overall well-being. 

Moreover, certain arrhythmias, particularly those involving ventricular 

tachycardia or fibrillation, can precipitate sudden cardiac arrest, a life-

threatening event requiring immediate medical intervention to restore 

normal heart rhythm and prevent irreversible damage or death. 

 

Beyond the acute consequences, cardiac arrhythmias are associated with an 

increased risk of adverse cardiovascular outcomes, including heart failure, 

stroke, and myocardial infarction (Nattel et al., 2017). The hemodynamic 

instability induced by arrhythmias can compromise cardiac function and 

exacerbate underlying cardiovascular conditions, leading to further 

complications and a higher likelihood of hospitalization and mortality. 

 

The economic burden of cardiac arrhythmias is also substantial, 

encompassing healthcare expenditures related to hospital admissions, 

diagnostic testing, pharmacological management, and invasive procedures 

such as catheter ablation or implantable device placement. Moreover, the 

indirect costs associated with arrhythmia-related disability, loss of 

productivity, and decreased quality of life further contribute to the 

socioeconomic impact of these conditions. 

 

2.2 Molecular Basis of Ion Channel Function and Dysfunction in 

Cardiac Arrhythmias 

 

Ion channels play a fundamental role in regulating the electrical activity of 

cardiac myocytes, thereby governing the initiation and propagation of 

action potentials essential for cardiac contraction (Nattel et al., 2017). 

These specialized transmembrane proteins facilitate the selective passage of 

ions across the cell membrane, generating the membrane potential changes 

that underlie the cardiac action potential. 
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The cardiac action potential is orchestrated by the sequential activation and 

inactivation of various ion channels, each contributing to distinct phases of 

depolarization and repolarization. Voltage-gated sodium (Na^+) channels 

initiate the rapid upstroke of the action potential by allowing the influx of 

sodium ions into the cell, leading to depolarization of the membrane. This 

phase is followed by the activation of voltage-gated potassium (K^+) 

channels, which promote the efflux of potassium ions, facilitating 

repolarization and restoration of the resting membrane potential. 

 

In addition to sodium and potassium channels, calcium (Ca^2+) channels 

also play a crucial role in cardiac electrophysiology, particularly in 

excitation-contraction coupling. L-type calcium channels facilitate the 

influx of calcium ions during the action potential, triggering calcium release 

from the sarcoplasmic reticulum and initiating myocardial contraction. 

Calcium influx also contributes to the plateau phase of the action potential, 

prolonging depolarization and modulating contractility. 

 

Dysfunction of ion channels can disrupt the delicate balance of ion fluxes, 

leading to arrhythmogenic substrates predisposing individuals to cardiac 

arrhythmias (Nattel et al., 2017). Genetic mutations, acquired disorders, and 

pharmacological interventions can alter ion channel function, resulting in 

conduction abnormalities, repolarization disturbances, and susceptibility to 

arrhythmia development. 

 

For example, mutations in genes encoding cardiac ion channels, such as 

SCN5A (sodium channel), KCNQ1/KCNE1 (potassium channel), and 

CACNA1C (calcium channel), have been implicated in various arrhythmia 

syndromes, including long QT syndrome, Brugada syndrome, and 

catecholaminergic polymorphic ventricular tachycardia. These mutations 

can disrupt channel gating, alter ion selectivity, or impair channel 

trafficking, leading to abnormal electrical activity and arrhythmia 

susceptibility. 
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Moreover, acquired disorders such as ischemia, heart failure, and 

electrolyte imbalances can further exacerbate ion channel dysfunction, 

creating a substrate conducive to arrhythmia initiation and perpetuation. 

Pharmacological agents, including antiarrhythmic drugs and medications 

used to treat other cardiovascular conditions, can also modulate ion channel 

function, sometimes with unintended proarrhythmic effects. 

 

 

2.3 Molecular Docking Methods and Applications in Drug Discovery 

 

Molecular docking is a computational technique widely used in drug 

discovery to predict the binding interactions between small molecules 

(ligands) and target proteins, with applications ranging from lead 

identification and optimization to virtual screening and structure-based drug 

design (Kitchen et al., 2004). The method involves simulating the 

geometric complementarity and non-covalent interactions between the 

ligand and receptor within the binding site, thereby predicting the most 

energetically favorable binding pose and affinity. 

 

Several molecular docking algorithms have been developed, each with its 

unique features and strengths. Among the most widely used are AutoDock, 

AutoDock Vina, and DOCK, which employ different scoring functions and 

search algorithms to explore ligand conformational space and optimize 

ligand-receptor interactions. These programs incorporate various 

parameters such as ligand flexibility, protein flexibility, and solvent effects 

to improve the accuracy and reliability of docking predictions. 

 

Molecular docking has numerous applications in drug discovery, including 

lead identification, where it can efficiently screen large chemical libraries to 

identify potential ligands with high binding affinity and specificity for the 

target protein (Kitchen et al., 2004). Virtual screening, another key 
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application, involves docking a database of compounds against a target 

protein to prioritize promising candidates for experimental testing based on 

their predicted binding energy and fit within the binding site. 

 

Structure-based drug design relies heavily on molecular docking to guide 

the rational optimization of lead compounds by systematically exploring the 

chemical space around the binding site and identifying key interactions 

driving ligand binding and potency (Kitchen et al., 2004). Docking 

simulations can also aid in understanding structure-activity relationships 

and predicting the impact of chemical modifications on ligand binding 

affinity and selectivity. 

 

Moreover, molecular docking serves as a valuable tool for studying protein-

ligand interactions, elucidating the molecular mechanisms underlying drug 

action and resistance, and guiding the design of novel therapeutic agents 

targeting various disease pathways. By integrating computational and 

experimental approaches, docking simulations can accelerate the drug 

discovery process, reduce costs, and increase the success rate of lead 

optimization and development. 

 

 

2.4 Phytochemicals 

 

Nerium oleander, a member of the Apocynaceae family, is referred to as 

Kaner in several Asian and Mediterranean nations. Because of the 

numerous bioactive chemicals that have been identified from this plant, 

such as cardiac glycosides, oleandrin, α-tocopherol, digitoxingenin, 

urosolic acid, quercetin, odorosides, and adigoside, it has been well-known 

to have substantial medicinal potential. One of N. oleander's most powerful 

and pharmacologically active phytochemicals is oleandrin, a saponin 

glycoside. Its extraordinary pharmacotherapeutic potential has been 
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described as antioxidant, antibacterial, neuroprotective, anti-HIV, anti-

inflammatory, and anticancer. (3) 

 

2.4.1 Mechanism of action  

 

In cardiac muscle cells, cardiac glycosides modify the activity of the 

sodium-potassium ATPase pump. These sodium-potassium pumps 

normally transfer sodium ions out and potassium ions in. Nevertheless, 

cardiac glycosides block this pump by keeping it stable in the E2-P 

transition state, which prevents sodium from being extruded and raises 

intracellular sodium concentration. Changes in extracellular potassium 

concentration may have an impact on therapeutic efficacy because 

potassium and cardiac glycosides compete with one another for binding to 

the ATPase pump, which affects potassium ion transport. Nevertheless, 

such negative effects can be prevented by closely monitoring the dosage. 

To reiterate the mechanism, elevated intracellular sodium levels block the 

action of NCX, a second membrane ion exchanger that is in charge of 

expelling calcium ions from the cell and sodium ions, which are present in 

a 3Na+/Ca2+ ratio. As a result, calcium ions are likewise not ejected and 

will instead start to accumulate within the cell. 

Increased calcium uptake via the SERCA2 transporter into the sarcoplasmic 

reticulum (SR) results from disturbed calcium homeostasis and elevated 

cytoplasmic calcium concentrations. Increased calcium release upon 

stimulation is made possible by higher calcium reserves in the SR, which 

enables the myocyte to contract more quickly and forcefully through cross-

bridge cycling. Because cardiac glycosides lengthen the AV node's 

refractory time, they also lower heart rate. Digoxin, for instance, increases 

cardiac output and lowers heart rate without significantly altering blood 

pressure; this property enables it to be used medicinally in the treatment of 

cardiac arrhythmia.(4) 
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For many years, it has been known that N. oleander is harmful. Cardiac 

glycosides are present in every part of the plant, although they are 

particularly abundant in the seeds and roots. Cardiac glycosides and 

digitoxin, a substance found in foxglove plants, share a similar structure. 

According to a number of research, N. oleander may have antibacterial, 

pesticidal, rodenticidal, and insecticidal properties. Five Nerium oleander 

leaves can be consumed and result in fatal poisoning. One N. oleander leaf 

was said to have extremely harmful effects on kids, though. It is 

controversial to report that a 7-year-old child who consumed three N. 

oleander leaves experienced mild poisoning but no further complications. 

After consuming five leaves of N. oleander, a woman in her adulthood 

experienced mild poisoning without experiencing severe symptoms. 

Consequently, figuring out the N. oleander toxicity lethal dose has not been 

fully determined, and additional research is needed to determine the plant's 

fatal dosages.(3) 

 

2.4.2Human Angiotensin Receptor 

 

Renin-angiotensin system (RAS) proteases methodically break down 

angiotensinogen, a serpin family protein that is mostly generated by the 

liver, to create hormone peptides. The systemic physiological response to 

renin-angiotensin syndrome (RAS) is regulated by specific cellular signals 

produced by cell surface receptors for at least three different angiotensin 

peptides. Angiotensin type 1 receptor (AT1 receptor) and type 2 receptor 

(AT2 receptor) are two well-characterized receptors. They react to the 

hormone angiotensin II, an octapeptide. A potential Ang receptor is the 

oncogene product MAS (1–7). Despite being G-protein coupled receptors 

(GPCRs), type 2 transmembrane proteins may be the binding sites for 

angiotensin IV in vivo. In addition to controlling inflammation, matrix-cell 

interactions, cell proliferation, survival, neurological, renal, and 

cardiovascular processes, these four receptors work together to control 

hemodynamic, neural, and endothelial activities. Angiotensin receptors are 

significant targets for treatment in a number of illnesses.(5) So in this 

dissertation we target Human angiotensin receptor with phytochemicals of  

Nerium oleander. 
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CHAPTER 3 

 

METHODOLOGY 
 

 

The methodology employed in this study integrates computational 

techniques with molecular docking simulations to identify potential 

phytochemical of Nerium oleander targeting 4YAY protein for treatment of 

cardiac arrhythmias.  

Here, we used PyRx for virtual screening of multiple 

ligands(phytochemicals) targeting a protein 4YAY. The following 

paragraphs detail the approach utilized for ligand selection, protein 

preparation, molecular docking, and validation procedures. 

 

1.Downloading the protein  

 

 Use PDB (www.rcsb.org) to download the 4YAY structure.  

 If you experience any issues loading the structure, you can download the 

PDBx/mmCIF format in addition to the PDB format as normal.  

 Put this file into a folder. 

 

2.Download the ligand 

 

Visit PubChem at www.pubchem.ncbi.nlm.nih.gov.  

 Look up "oleanolic acid" as a compound. Download the corresponding 3D 

conformer in SDF format. Put it in a separate folder. 

 Download the 3D structures of Oleandrin, Alpha tocopherol, Adigoside, 

Scopolin and Ouabain the same way as mentioned in previous steps and 

save it. 
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3.Preparing the protein 

 The binding location and binding residues must be known in order to 

prepare the protein for docking. They may involve two chains of 

proteins, or they may be found in just one. Examine the related paper 

that was released for that structure. 

 Here we know the binding site of 4YAY protein. 

 Open pdb file and delete hetatoms. Since the structure we're utilizing is 

a crystal structure complexed with ligand(s), we remove the bound 

ligand by deleting hetatoms from the PDB file in order to dock the 

desired ligand with the protein at that specific spot. We won't obtain the 

right results if we dock our ligand without first eliminating the 

complexed ligand. Moreover, we can quickly eliminate ligands by using 

BIOVIA discovery studio to see the protein. 

 Extra chains were removed from the protein structure to avoid the 

complexity. 

 Here we kept chain A and rest were removed. Now save the file as 

“protein.pdb”. 

 We have prepared our protein structure to proceed further for docking.  

 

Figure 3.1- Screenshot showing loading of protein in discovery studio 
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Figure 3.2- Screenshot showing protein after modification 

 

 

Figure 3.3- Screenshot showing protein after modification 

 

4.Performing docking using pyrx 

 

Autodock Vina will be the docking tool that we use. We use the Vina algorithm 

to dock it in Pyrx. Launch Pyrx GUI and followed the steps given below: 
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   4.1Protein Loading 

 Select "File" -> "Load Molecule" or simply click the first icon in the 

upper left corner. Choose the protein structure that you downloaded. 

referred to here as "4YAY.pdb." 

 convert pdb format of protein to pdbqt by right clicking on 4YAY 

then on display and now select macromolecule. 

 

 

Figure 3.4- Screenshot showing conversion of protein file pdb to pdbqt 

 

4.2 Ligand loading 

 

 In PyRx , click on OpenBabel and select on insert new item present 

on bottom right corner. 

 Now select each ligand from folder one by one and upload it.  
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Figure 3.5- Screenshot showing loading of ligands 

 After uploading all ligands , right click on ligand and select 

minimise all to decrease the energy.  

 

 

Figure 3.6- Screenshot showing minimisation of energy of ligand 
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 Again right click and select convert all to AutoDock ligand (pdbqt) 

to convert all ligands to pdbqt format. 

 

 

Figure 3.7- Screenshot showing conversion of all ligands to pdbqt 

 

Figure 3.8- Screenshot showing display of all ligands 
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5.Defining ligands and proteins  

 

The loaded protein and ligand are shown under the "Molecules" tab. It is now 

necessary to identify which is a ligand and which is a protein. • Right-click on the 

protein –> “Autodock” –> “Make Macromolecule” to accomplish that.  

Perform a right-click on the ligand, select "Autodock," then "Make Ligand."After 

that, you'll see that it has automatically prepared their PDBQT files under the 

'Autodock' page.  

 

 

Figure 3.9- Screenshot showing grid box 

6.Defining grid box 

 

 Now click on Vina Wizard and select start option on bottom right 

corner. Start selecting protein and ligand one by one by pressing 

shift and control button. 

 Click on forward. Grid box appears. Return to the 'Molecules' tab 

located on the right-hand side. Click the loaded protein's "+" 

symbol.  
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 All of the residues in the chain will be visible to you.  

 To choose the binding residues, right-click on the residue and 

choose Atoms, Display, Label, and Atoms. The atoms will start to 

show up on the protein.  

Now make the appropriate adjustments to the grid box so that it 

contains all of the selected residues. The ligand does not need to be 

enclosed within the grid box.  

 

 

Figure 3.10- Screenshot showing defining of grid box 

 

7.Running vina for docking 

 

 To adjust the exhaustiveness, simply enter the desired number in the box 

located in the left-bottom corner. Once everything has been adjusted, press 

the "Forward" button. 

 Docking will begin, and the processing will be shown. The bottom panel will 

display the poses and their binding affinities after the docking process is 

complete. It will show all poses along with RMSD values. Save your file in 

excel sheet.  
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 Now analyse the result and the one ligand which has the highest energy with 

negative sign is selected. Again open pyrx tab and click on AutoDock and 

select macromolecule and select the ligand with highest binding energy. Now 

right click and select display then all models of the ligands gets displayed and 

select your desired model and save it in pdb format. 

 

 

Figure 3.11- Screenshot showing running of vina wizard 
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Figure 3.12- Screenshot showing binding affinity of ligands with protein 

 

Figure 3.13– Screenshot showing macromolecular structure of protein with 

different ligands 

 8.Open Discovery Studio: - Start a new project in Discovery Studio. 

 

 9.Protein Structure Import: 
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 Open Discovery Studio and import the structure of the target protein. 

 Choose your protein structure file (such as *.pdb) by using File > Open. 

 

Figure 3.14- Screenshot showing visualisation of protein structure in 

discovery studio 

 

10. Import Docked Ligand Conformations: 

 

 Import the docked ligand conformations. 

 Use File > Open and select the converted ligand file (e.g., *.pdb or *.mol2). 

 

 

Figure 3.15- Screenshot showing structure of Oleanolic acid 
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11.Visualize Docked Poses: 

 

 Display the protein and ligand together in the 3D workspace. 

 Use the View > Sequence panel to ensure the correct structures are loaded. 

 Adjust the display settings to show interactions clearly (e.g., stick or surface 

representations). 

 

12.Analyse Binding Affinities: 

 

 Check the binding affinities associated with each docked pose. 

 This information can be found in the PyRx log files or the output summary 

from PyRx.. 

 Record the binding affinity scores (typically in kcal/mol) for reference. 

 

13. Examine Binding Interactions: 

 

 Use the Analyze > Receptor-Ligand Interactions tool to identify and visualize 

key interactions between the ligand and the protein. 

 Highlight hydrogen bonds, hydrophobic interactions, salt bridges, and π-π 

stacking interactions. Check for consistency with known binding sites or 

important residues in the binding pocket. 

 

14.Evaluate Docked Poses: 

 

 Compare multiple docked poses to determine if there is a consensus 

binding mode. 

 Use the View > Compare tool to overlay different conformations and 

evaluate their similarity. 

 Consider the Root Mean Square Deviation (RMSD) values to understand 

the variance among poses. 
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                                                     CHAPTER 4 

 

RESULT 
 

 

The results of the molecular docking simulations revealed promising 

candidate for treatment in cardiac arrhythmias. Through virtual screening of 

a diverse compound from Nerium oleander against protein 4yay, several 

compounds were identified with favourable binding affinities and potential 

therapeutic effects. The phytochemical which has highest binding score is 

selected and its model is studied using discovery studio for visualisation of 

interaction. We also check the binding score of Ouabain which is already in 

use for the treatment of cardiac arrythmia with our target protein. 

 

The following images show the docking result of different phytochemicals 

with 4yay 

 

 



P a g e  | 39 

 

 

 

 

By comparing our docking result we identified that the Oleanolic acid have 

highest binding score of -10.5 with Energy E=689.79. Then we studied its 

model further and check its interactions with our target protein. 
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STRUCTURE OF STUDIED NATURAL COMPOUNDS 

               

 

Figure 4.1- Oleanolic acid                                     Figure 4.2- Alpha-tocopherol  

  

                                               

              

   

 Figure 4.3- Scopolin                                             Figure 4.4- Oleandrin  
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Figure 4.5- Adigoside                                          Figure 4.6- Ouabain 

 

 

Docking of different phytochemical with 4yay 

Docking of Adigoside with 4yay  

Docking results in binding between adigoside and 4yay shows 

E score=1024.97, binding affinity -8.3 kcal/mol and rmsd value =0 

 

Figure 4.7- Docking of Adigoside with 4YAY 
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       Docking of Alpha -tocopherol with 4YAY 

Docking results in binding between alpha-tocopherol with 4yay shows 

E score= 288.57, binding affinity -8.5kcal/mol and rmsd value 0 

 

Figure 4.8 – screenshot showing docking of alpha-tocopherol with 4YAY 

        

        Docking of Ouabain with 4YAY 

Docking results in binding between ouabain with 4yay shows 

E score =1042.18, binding affinity -7.4 kcal/mol and rmsd 0 

 

Figure 4.9-Screenshot showing docking of Ouabain with 4YAY 
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       Docking of Scopolin with 4yay 

Docking results in binding between scopolin with 4yay shows 

E score=407.16, binding affinity -7.9kcal/mol and rmsd value 0 

 

Figure 4.10- Screenshot of docking of scopolin with 4YAY  

 

Docking of Oleandrin with 4YAY  

Docking results in binding between oleandrin with 4yay shows 

E score=1054.96, binding affinity -8.2kcal/mol and rmsd value 0 

 

Figure 4.11- Screenshot showing docking of Oleandrin with 4YAY 
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Docking of Oleanolic acid with 4YAY 

Docking results in binding between oleanolic acid with 4yay shows 

E score=689.79, binding affinity -10.5kcal/mol and rmsd 0 

 

Figure 4.12- Screenshot showing docking of Oleanolic acid with 4YAY 

 

From the above result we identify that Oleanolic acid has high binding 

affinity with our target protein so we studied its 2-D and 3-D structure 

which is shown below. 

 

 

Figure 4.13- Screenshot showing 3-D and 2-D structure of Oleanolic acid 
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Discussion 

 

In this study, the docking simulation technique was used to identify the potential 

natural compound used in the treatment of cardiac arrythmia. Analysis of docking 

scores and binding poses indicated that compounds from the Nerium oleander 

exhibited varying degrees of interaction with the active sites of target. Docking 

simulations predicted specific binding interactions, including hydrogen bonds, π-π 

stacking, and hydrophobic interactions, contributing to ligand binding and 

stabilization within the binding site (Kumar et al., 2019).The docking results 

obtained from molecular simulations provide valuable insights into the binding 

interactions between potential phytochemical and target protein which in turn 

targets ion channels implicated in cardiac arrhythmias. Analysis of docking scores 

and binding poses offers crucial information regarding ligand binding affinity, 

specificity, and mode of interaction within the target proteins. The docking scores, 

often represented as binding energies or scoring functions, quantify the predicted 

strength of ligand binding to the target protein. Lower docking scores correspond 

to more favourable binding interactions, indicating higher affinity and stability of 

the ligand-protein complex. The oleanolic acid found in Nerium oleander and also 

present in many plants have high binding affinity with the target protein. The 

binding interaction energy of oleanolic acid with target 4yay is E=689.79 and 

highest binding score of -10.5kcal/mol. It is a triterpenoid and have antioxidant 

property which helps in treatment of cardiac arrythmia. Although some research 

have indicated that Nerium oleander is hazardous in nature, this plant has the 

potential to treat cardiac arrhythmia because to the presence of several cardiac 

glycosides which have as much as potential like Ouabain which is extracted from 

plant strophantus seeds and already have been used. So we can work on the 

dosage of the compounds obtained from Nerium oleander and maybe used their 

compounds as therapeutic approach in cardiac arrythmia while keeping in mind 

its toxicity. 
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Recommendations for Future Research 

 

Even while antiarrhythmic medications (AADs) continue to be among the most 

significant therapeutic alternatives, there are still a number of issues with their 

administration that need to be resolved. These issues include their limited 

therapeutic window and adverse drug reactions, which should be taken into 

account in future drug research. It is therefore necessary to look into cutting-

edge, secure, and efficient treatment alternatives with antiarrhythmic action. 

 

Experimental Validation: Future research efforts should focus on 

experimental validation and optimization of ligand compounds identified 

through computational modelling, including assessment of binding 

affinities, pharmacokinetic properties, safety profiles, and efficacy in 

relevant disease models. 

 

 Clinical Translation: Further research is needed to translate 

computational  predictions into clinically viable therapeutics, including 

preclinical validation studies, formulation development, and clinical trials 

to evaluate safety and efficacy in human patients. 

 

Personalized Medicine Approaches: Investigating the potential of 

personalized medicine approaches based on patient-specific genetic 

mutations or ion channel subtypes can improve treatment outcomes and 

inform the development of targeted therapeutic strategies for individual 

patients. 

 

By addressing these recommendations for future research, the field can 

further advance our understanding of cardiac arrhythmias and facilitate the 

development of innovative therapeutic interventions for improving patient 

care and outcomes. 
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